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FlexRay Automated Testing—At a Glance

Overview

Keysight FlexRay Compliance Test Application software for Keysight InfiniiVision 
3000 X-Series, 4000 X-Series, 6000 Series, and 7000 Series Oscilloscopes gives 
you a fast and easy way to verify and debug the physical layer characteristics of 
your FlexRay designs. The FlexRay Compliance Test Application lets you 
automatically run FlexRay conformance tests and displays the results in a flexible 
report format. In addition to the measurement data, the report provides margin 
analysis that shows how closely your device passed or failed each test.

The FlexRay Compliance Test Application:

• Lets you select individual or multiple tests to run.

• Lets you decide the type of hardware connection to use (single-ended or 
differential) and shows you how to make oscilloscope connections to the 
Device Under Test based on selected connection type.

• Automatically checks for proper Oscilloscope configuration.

• Automatically sets up the Oscilloscope for each test.

• Provides detailed information for each test that has been run and lets you 
specify the thresholds at which marginal or critical warnings appear.

• Creates a printable HTML report of the tests that have been run.

For more information, see:

• Chapter 1, “Prerequisites,” starting on page 7

• "Required Equipment and Software" on page 8

• "Installing Keysight IO Libraries Suite" on page 9

• "Installing the Software" on page 13

• "Licensing the FlexRay Test Application" on page 13

• Chapter 2, “About the Tests,” starting on page 15

• "1.1 Eye Diagram Measurement" on page 16

• "1.2 Amplitude Measurement" on page 22

• "1.3 Transition Time Measurement" on page 28

• "1.4 TSS Width Measurement" on page 34

• "1.5 Mean Corrected Cycle Time" on page 38

• "1.6 Signal Integrity Voting Tests" on page 42

For an HTML version to understand how to use the test application & its various 
features, click Help>Contents... within the FlexRay Compliance Test Application to 
see the Keysight FlexRay Compliance Test Application Online Help.

See Also • The electrical and timing parameters are specified by FlexRay Communications 
System Electrical Physical Layer Specification, Version 2.1, Revision E.
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Before running the automated tests, you must acquire the required equipment and 
software and calibrate the Oscilloscope. After the Oscilloscope has been 
calibrated, you are ready to start the FlexRay Compliance Test Application and 
perform measurements.
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1 Prerequisites
 

Required Equipment and Software

In order to run the automated tests, you need the following equipment and 
software:

• One of the following InfiniiVision 4-channel oscilloscopes:

• 4000 X-Series oscilloscope with:

• FLEX license (order DSOX4FLEX).

• MASK license (order DSOX4MASK).

• 3000 X-Series oscilloscope with:

• FLEX license (order DSOX3FLEX).

• MASK license (order DSOX3MASK).

• SGM license (order DSOX3SGM).

• 6000 Series or 7000 Series oscilloscope with:

• Software version 6.00 or greater.

• Option FLX (N5432C) license, or Option FRS (N5432A) with N5432U 
upgrade license.

• Differential active probe. Keysight recommended probes include:

• N2792A 200 MHz differential active probe.

• N2793A 800 MHz differential active probe.

• 113xA InfiniiMax differential active probe.

• FlexRay Physical Layer Conformance Test Application software.

• Keysight I/O libraries version 15.0 or greater.

• FlexRay device under test.

Controller PC Requirements

To ensure adequate performance, the FlexRay Physical Layer Conformance Test 
Application requires a controller PC with these characteristics:

• Processor: Intel Pentium 4 Processor 3 Ghz or better.

• RAM: 2 GB or better.

• Operating System: Windows XP 32-bit.
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Installing Keysight IO Libraries Suite

The controller PC must have installed Keysight I/O libraries version 15.0 or greater.

The Keysight IO Libraries Suite software can be downloaded from the Keysight 
web site at: "www.keysight.com/find/iolib"

• “Adding Your Oscilloscope Using Keysight Connection Expert" on page 9

Adding Your Oscilloscope Using Keysight Connection Expert

This procedure only needs to be performed once for each oscilloscope used to 
perform FlexRay conformance measurements.

1 On the PC that will run the FlexRay Test Application, choose Start > All Programs 
> Keysight IO Libraries Suite > Keysight Connection Expert from the Windows Start 
menu. Or, click on the Keysight IO Control icon in the taskbar, and choose 
Keysight Connection Expert from the popup menu.

2 In the Keysight Connection Expert application, instruments connected to the 
controller's USB and GPIB interfaces should automatically appear. (You can 
click Refresh All to update the list of instruments on these interfaces.)

NOTE The menus and dialogs shown here may differ slightly depending on the version of the 
Keysight IO Libraries Suite.

http://www.keysight.com/find/iolib
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1 Prerequisites
 

You must manually add instruments on LAN interfaces:

a Right-click on the LAN interface, choose Add Instrument from the popup 
menu, and click OK in the resulting dialog (because the desired interface is 
already selected).

b If the oscilloscope is on the same subnet, select it and click OK.
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Otherwise, click Add Address (or if you have a version of the IO Libraries that 
doesn't have Auto Find, select the LAN interface and click OK).

c In the next dialog, select either Hostname or IP address, and enter the 
oscilloscope's hostname or IP address.

d Click Test Connection.
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1 Prerequisites
 

e If the instrument is successfully opened, click OK to close the dialog. If the 
instrument is not opened successfully, go back and verify the LAN 
connections and the oscilloscope setup.

3 In the Keysight Connection Expert application, choose File > Exit from the menu 
to exit the application.
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Installing the FlexRay Physical Layer Conformance Test Application 
software

You must install the FlexRay Physical Layer Conformance Test Application on a 
controller PC that is connected to the InfiniiVision 3000 X-Series, 4000 X-Series, 
6000 Series, or 7000 Series oscilloscope via LAN or USB.

• “Installing the Software" on page 13

• “Licensing the FlexRay Test Application" on page 13

Installing the Software

Install the FlexRay Test Application software from one of the following download 
web pages:

• "http://www.keysight.com/find/flexray3000" (for 3000 X-Series oscilloscopes)

• "http://www.keysight.com/find/flexray4000" (for 4000 X-Series oscilloscopes)

• "http://www.keysight.com/find/flexray" (for 6000 Series and 7000 Series 
oscilloscopes)

To install the software:

1 If you have an InfiniiVision 6000 Series or 7000 Series oscilloscope, make sure 
you have version 6.00 or higher of the oscilloscope firmware by choosing 
[Util ity] > Service > About Oscilloscope from the front panel.

2 Download the FlexRay Physical Layer Conformance Test Application install 
package from the Keysight web site to your controller PC.

3 Run the install package executable file and follow its instructions.

Be sure to accept the installation of the .NET Framework software; it is required 
in order to run the FlexRay Physical Layer Conformance Test Application.

Licensing the FlexRay Test Application

The FlexRay Physical Layer Conformance Test Application software comes 
standard with:

• DSOX3FLEX on 3000 X-Series oscilloscopes.

• DSOX4FLEX on 4000 X-Series oscilloscopes.

• Option FLX (N5432C) on 6000 Series and 7000 Series oscilloscopes, which 
automatically licenses Option FRC. Option FRC in the oscilloscope is the only 
requirement.

Previous Option FRS (N5432A) customers can order the N5432U upgrade to 
get Option FRC.

http://www.keysight.com/find/flexray3000
http://www.keysight.com/find/flexray4000
http://www.keysight.com/find/flexray
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1 Prerequisites
 

Option FRC is an oscilloscope-locked license — this enables any FlexRay 
Physical Layer Conformance Test Application to connect to and use a licensed 
oscilloscope. This type of license permits multiple users to share an 
oscilloscope using a single license.

To install option
licenses

On 3000 X-Series and 4000 X-Series oscilloscopes:

1 Follow the instructions on the Entitlement Certificate you received with your 
FlexRay option purchase.

2 Your license file will be delivered via e-mail.

License files are loaded from a USB storage device using the oscilloscope's File 
Explorer.

On 6000 Series and 7000 Series oscilloscopes:

1 Follow the instructions on the Entitlement Certificate you received with your 
FlexRay option purchase.

You will need the unique identifier for the oscilloscope. You can find the 
Instrument ID by choosing [Util ity] > Options > Licenses > Show l icense information 
from the front panel.

2 Your license will be delivered via e-mail.

The e-mail will contain an alphanumeric code. Enter this code directly into your 
instrument using the oscilloscope's interface (see the oscilloscope 
documentation for instructions on how to install feature licenses).
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2 About the Tests
 

1.1 Eye Diagram Measurement

Test Overview

The purpose of this test is to verify that the DUT meets the specified eye template 
requirements as specified in Chapter 7, Figure 7-2 (TP1) and Figure 7-3 (TP4) of 
the FlexRay Communications System Electrical Physical Layer Specification, 
Version 2.1, Revision E.

Figure 1Selection of Eye Diagram Tests in the Compliance Test Application
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TP1 Eye Diagram—A FlexRay bus driver shall meet the eye diagram requirements 
with test load defined in section 7.2.1 of the FlexRay Communications System 
Electrical Physical Layer Specification, Version 2.1, Revision E; a TxD signal with 
rise and fall times of 6ns (which is 20%-80% of V10) and a perfect bit duration of 
100ns.

Figure 2TP1 FlexRay Mask
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2 About the Tests
 

TP4 Eye Diagram—A prerequisite to successful decoding of the FlexRay 
communication element in the receiving communication controller is through a 
proper analog input signal at the receiving bus driver. You may assess this with the 
eye-diagrams defined in this test.

Figure 3TP4 FlexRay Mask
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References

Figure 4Required Waveform at TP1
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2 About the Tests
 Figure 5Required Waveform on TP4 at 10 Mbps

Eye Diagram Mask Test

Only for systems with a baud rate of 10 Mbps, the eye diagram has captures and 
overlays of multiple bits from ALL frames that are referenced to triggering on 
alternate rising and falling edges at the ideal 0.0 V crossing point at the selected 
test plane (which is either TP1 — output of a Bus Driver or TP11 — output of an 
Active Star). The eye diagram test runs for a default value of 100000 captured bits, 
which is set under Number of Waveforms (Eye-d iagram tests). You may modify this 
value in the Configure tab of the FlexRay Compliance Test Application. The 
measured results, which consists of number of failed bits and the overall Pass/Fail 
criteria, are compared against the appropriate specified mask, that is:

TP1—Standard Voltage Transmitter or Increased Voltage Transmitter

TP11—Standard Voltage Transmitter or Increased Voltage Transmitter

The FlexRay Communications System Electrical Physical Layer Specification, 
Version 2.1, Revision E specifies that the transmitter eye diagram mask test is 
primarily used to test differential outputs of Bus Driver and Active Star devices 
when the input for these devices is stimulated using a 10 Mbps pulse train from a 
signal generator source. When you perform measurements using frames 
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generated by a random FlexRay Communication Controller, the test results are 
considered as information-only and you must consider these results for physical 
layer conformance.

In addition, if you are testing a synchronous multi-node system, note that since 
the eye diagram test overlays bits from ALL frames, some of the captured bits 
(generated from frames of the other nodes/ECUs in the system) are actually 
“received” bits and not “transmitted” bits. If this test passes, it is an assurance that 
the quality of the signals from the transmitter under test also passes. However, if 
this test fails, the cause of failure could be the testing of attenuated signals that 
are generated from nodes/ECUs, which are remotely located from the transmitter 
under test.

Test Procedure

1 Configure the FlexRay DUT such that it acts as a source for FlexRay signal.

2 Reset the Oscilloscope.

3 Load either TP1 or TP4 mask file on the Oscilloscope.

4 Stop Acquisitions.

5 Clear the Oscilloscope Display.

6 Set the minimum number of acquisitions to 100K tests.

7 Start the Mask Test.

8 Run the Total Failure query when the test is complete.

9 Transfer the Image.

10 Compare the test results with the compliance test limits.

Expected/Observable Results

For all eye diagram tests, the signal must not violate the eye mask specified in 
Figure 1.1.1 and Figure 1.1.2 of the FlexRay Communications System Electrical 
Physical Layer Specification, Version 2.1, Revision E.
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2 About the Tests
 

1.2 Amplitude Measurement

Test Overview

The purpose of this test is to verify that the Amplitude (Data1, Data0 and Idle 
Level) of the Device Under Test (DUT) is within the conformance limits as specified 
in Figure 2.1.1 and Figure 2.1.2 of the FlexRay Communications System Electrical 
Physical Layer Specification, Version 2.1, Revision E.

Figure 6Selection of Amplitude Measurement Tests in the Compliance Test Application
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Data1 Amplitude (+uBDTx-active): Measures the maximum steady-state level 
(Vtop) of the differential Data1 (active high) signal within the specified frame at a 
transmitter test plane differential probing point. Compare the measured results 
against the specified test limits of 600mV < +uBDTx-active < 2.0V.

Data0 Amplitude (-uBDTx-active): Measures the minimum steady-state level 
(Vbase) of the differential Data0 (active low) signal within the specified frame at a 
transmitter test plane differential probing point. Compare the measured results 
against the specified test limits of -2.0V < -uBDTx-active < -600mV.

Figure 7Measuring Data1 and Data0
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2 About the Tests
 

Idle Level (uBDTx-Idle): Measures the average voltage level of the idle level signal 
prior to the occurrence of the TSS event of the specified frame at a transmitter test 
plane differential probing point. Compare the measured results against the 
specified limits of -30mV < uBDTx-Idle < +30 mV.

Figure 8Measuring Idle Level

References

Table 1 Minimum and Maximum Data Values for Amplitude Measurement tests

Name Description Min Max Unit

uRx uBus@TP4 400 3000 mV

dRxia Transition time Idle=>Data_0 18 22 ns

dRxai Transition time Data_0=>Idle 18 22 ns

dActive Minimum time Data_0 590 610 ns

dIdle Minimum time Idle 590 610 ns

uBDTxactive Absolute value of uBus, while sending (*) 600 2000 mV

uBDTxidle Absolute value of uBus, while Idle (*) 0 30 mV

dBDTx10 Transmitter delay, negative edge (***) - 100 ns

dBDTx01 Transmitter delay, positive edge (***) - 100 ns

dBDTxAsym Transmitter delay mismatch (***)
|dBDTx10 - dBDTx01|

- 5 ns
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Test Procedure

Initial Setup

1 Configure the FlexRay DUT such that it acts as a source for FlexRay signal.

2 On the Oscilloscope:

a Set to Default Setup.

b Set Triggered Mode as Normal.

c Set the Initial V/div = 1V/div, Offset = 0V.

d On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as Signal Generator Clock gated by T-Enable:

• Trigger = 50ns < +PW < 150ns

• Trigger level = -300mV

• Noise Reject = ON

• Timebase = 20ns/div, Delay = 0.0s

e On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Serial Decode = FlexRay = ON

• VPT1000 mode = Synchronous or Asynchronous

• Trigger Type = FlexRay, Mode = Frame

• Frame ID = N, Cycle Rep = All

• Delay = 0.0

• If 10 Mbps, Timebase = 2.0us/div

• If 5 Mbps, Timebase = 4.0us/div

dBDTxAsym2 Transmitter delay mismatch (****)
|dBDTx10 - dBDTx01|

- 4 ns

dBusTx10 Fall time differential bus voltage (**)
(80% to 20%)

6 18.75 ns

dBusTx01 Rise time differential bus voltage (**)
(20% to 80%)

6 18.75 ns

Table 1 Minimum and Maximum Data Values for Amplitude Measurement tests

Name Description Min Max Unit
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2 About the Tests
 

• If 2.5 Mbps, Timebase = 8.0us/div

f Measure Vpp with stats.

g Perform Query measurement.

h Compute V/div-optimum = ~Vpp(max)/6

i Set selected Channel V/div = V/div-optimum

j On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Measure “T@V” on first falling edge @ V = -300mV

• Result = dTSS (This value of time denotes the beginning of the frame relative 
to the trigger point you set. This value is used later for delay settings.)

k Clear measurement.

Data1 and Data0 Amplitude Measurement (+uBDTx-active, -uBDTx-active, 
+uRx-data, -uRx-data)

1 On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

a On the Oscilloscope:

• (For Baud Rate 10Mbps) Set Timebase = 200ns/div, Delay = -550ns

• (For Baud Rate 5Mbps) Set Timebase = 400ns/div, Delay = -800ns

• (For Baud Rate 2.5 Mbps) Set Timebase = 800ns/div, Delay = -1.5us

b Measure with Stats:

• Vmax

• Vtop (+uBDTx-active or +uRx-data)

• Vbase (-uBDTx-active or -uRx-data)

• Vmin

c Stop Acquisition.

d Run a query for measurement stats

e Transfer image

f Compare the test results with the compliance test limits.

Idle Level Measurements (+uBDTx-idle, +uRx-idle)

1 On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

a On the Oscilloscope:

• (For Baud Rate 10Mbps) Set Timebase = 20ns/div, Delay = dTSS-1us

• (For Baud Rate 5Mbps) Set Timebase = 40ns/div, Delay = dTSS-2us

• (For Baud Rate 2.5 Mbps) Set Timebase = 80ns/div, Delay = dTSS-4us
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2 On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as Signal Generator Clock gated by T-Enable:

a On the Oscilloscope:

• Trigger = +PW>200ns

• Delay = -200ns

b Infinite Persistence = ON

c Measure Vmax, Vmin, Vaverage, Vstd-dev with stats

d Clear Display

e Query measurement with stats

f Transfer image

g Infinite Persistence = Off

h Transfer image

Expected/Observable Results

The amplitude level must meet the following limits as per the FlexRay 
Communications System Electrical Physical Layer Specification, Version 2.1, 
Revision E:

• 600mV < uRx-active < 2000mV

• -600mV < -uRx-active < -2000mV

• -30mV < uRx-idle < 30mV

• 400mV < uBDTx-active < 3000mV

• -400mV < -uBDTx-active < -3000mV

• -30mV < uBDTx-idle < 30mV
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2 About the Tests
 

1.3 Transition Time Measurement

Test Overview

The purpose of this test is to verify that the Transition Time (Data1 and Data0) of 
the Device Under Test (DUT) is within the conformance limits specified in Figure 
2.1.1 and Figure 2.1.2 of the FlexRay Communications System Electrical Physical 
Layer Specification, Version 2.1, Revision E.

Figure 9Selection of Transition Time Measurement Tests in the Compliance Test 
Application
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Rise Time—Data0 to Data1 (dBusTx01): Measures the rising edge transition time of 
a FlexRay pulse within the specified frame at a transmitter test plane probing point 
based on a 20% to 80% measurement threshold level criteria. Compare the 
measured results against the specified limits of 6.0ns < dBusTx01 < 18.75ns.

Figure 10Rise Time Measurement on Data0 to Data1 Transition
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2 About the Tests
 

Fall Time—Data1 to Data0 (dBusTx10): Measures the falling edge transition time of 
a FlexRay pulse within the specified frame at a transmitter test plane probing point 
based on 80% to 20% measurement threshold level criteria. Compare the 
measured results against the specified limits of 6.0ns < dBusTx01 < 18.75ns.

Figure 11Fall Time Measurement on Data1 to Data0 Transition

References

Table 2 Minimum and Maximum Data Values for Transition Time Measurement tests

Name Description Min Max Unit

uRx uBus@TP4 400 3000 mV

dRxia Transition time Idle=>Data_0 18 22 ns

dRxai Transition time Data_0=>Idle 18 22 ns

dActive Minimum time Data_0 590 610 ns

dIdle Minimum time Idle 590 610 ns

uBDTxactive Absolute value of uBus, while sending (*) 600 2000 mV

uBDTxidle Absolute value of uBus, while Idle (*) 0 30 mV

dBDTx10 Transmitter delay, negative edge (***) - 100 ns

dBDTx01 Transmitter delay, positive edge (***) - 100 ns

dBDTxAsym Transmitter delay mismatch (***)
|dBDTx10 - dBDTx01|

- 5 ns
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Test Procedure

Initial Setup

1 Configure the FlexRay DUT such that it acts as a source for FlexRay signal.

2 On the Oscilloscope:

a Set to Default Setup.

b Set Triggered Mode as Normal.

c Set the Initial V/div = 1V/div, Offset = 0V.

d On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as Signal Generator Clock gated by T-Enable:

• Trigger = 50ns < +PW < 150ns

• Trigger level = -300mV

• Noise Reject = ON

• Timebase = 20ns/div, Delay = 0.0s

e On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Serial Decode = FlexRay = ON

• VPT1000 mode = Synchronous or Asynchronous

• Trigger Type = FlexRay, Mode = Frame

• Frame ID = N, Cycle Rep = All

• Delay = 0.0

• If 10 Mbps, Timebase = 2.0us/div

• If 5 Mbps, Timebase = 4.0us/div

dBDTxAsym2 Transmitter delay mismatch (****)
|dBDTx10 - dBDTx01|

- 4 ns

dBusTx10 Fall time differential bus voltage (**)
(80% to 20%)

6 18.75 ns

dBusTx01 Rise time differential bus voltage (**)
(20% to 80%)

6 18.75 ns

Table 2 Minimum and Maximum Data Values for Transition Time Measurement tests

Name Description Min Max Unit
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• If 2.5 Mbps, Timebase = 8.0us/div

f Measure Vpp with stats.

g Perform Query measurement.

h Compute V/div-optimum = ~Vpp(max)/6

i Set selected Channel V/div = V/div-optimum

j On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Measure “T@V” on first falling edge @ V = -300mV

• Result = dTSS (This value of time denotes the beginning of the frame relative 
to the trigger point you set. This value is used later for delay settings.)

k Clear measurement.

Rise Time—Data1 and Data0 (dRx01 & dBusTx01)

1 Run the tests on the FlexRay Compliance Test Application.

2 On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as Signal Generator Clock gated by T-Enable:

a On the Oscilloscope:

• Trigger = 50ns < -PW < 150ns

• Timebase = 20ns/div, Delay = 0.0s

b On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Cycle Rep = 8, Cycle Base = 1

• Timebase = 20ns/div

• (For Baud Rate 10Mbps) Delay = -400ns

• (For Baud Rate 5Mbps) Delay = -500ns

• (For Baud Rate 2.5 Mbps) Delay = -670ns

c For Receiver Tests:

• Upper Threshold = +300mV

• Lower Threshold = -300mV

d For Transmitter Tests:

• Upper Threshold = 80%
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• Lower Threshold = 20%

e Measure Rise Time with stat.

f Stop Acquisition.

g Run a query for measurement stats.

h Transfer image.

i Compare the test results with the compliance test limits.

Fall Time—Data1 and Data0 (dRx10 & dBusTx10)

1 Run the tests on the FlexRay Compliance Test Application.

2 On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as Signal Generator Clock gated by T-Enable:

a On the Oscilloscope:

• Trigger = 50ns < +PW < 150ns

• Timebase = 20ns/div, Delay = 0.0s

b On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Cycle Rep = 8, Cycle Base = 1

• Timebase = 20ns/div

• (For Baud Rate 10Mbps) Delay = -200ns

• (For Baud Rate 5Mbps) Delay = -100ns

• (For Baud Rate 2.5 Mbps) Delay = -125ns

c Measure Rise Time with stat.

d Stop Acquisition.

e Run a query for measurement stats.

f Transfer image.

g Compare the test results with the compliance test limits.

Expected/Observable Results

The transition time must meet the following limits as per the FlexRay 
Communications System Electrical Physical Layer Specification, Version 2.1, 
Revision E:

• dRx10 < 22.5ns

• 6ns < dRx01 < 22.5ns

• 6ns < dBusTx10 < 18.75ns

• 6ns < dBusTx01< 18.75ns
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1.4 TSS Width Measurement

Test Overview

The purpose of this test is to verify that the width of the Transmission Start 
Sequence of the Device Under Test (DUT) is within the conformance limits 
specified in the FlexRay Communications System Electrical Physical Layer 
Specification, Version 2.1, Revision E.

Figure 12Selection of TSS Width Measurement Test in the Compliance Test Application

TSS-width (gdTSSTransmitter)—Measures the width of the Transmission Start 
Sequence (TSS) low pulse of the specified frame at a transmitter test plane 
differential probing point. Compare the measured results against the specified 
limits of:

(For Baud Rate 10Mbps) 6gdBit (590ns) < gdTSSTransmitter < 15gdBit (1.51us)
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(For Baud Rate 5Mbps) 4gdBit (780ns) < gdTSSTransmitter < 8gdBit (1.62us)

(For Baud Rate 2.5 Mbps) 3gdBit (1.16us) < gdTSSTransmitter < 5gdBit (2.04us)

These test limits are based on absolute maximum and minimum possible TSS 
widths and also include Oscilloscope measurement resolution margin of +/- 10ns 
for a baud rate of 10Mbps, +/-20ns for a baud rate of 5Mbps or +/-40ns for a baud 
rate of 2.5Mbps. Note that you may run tests by manually entering precise test 
limits in the FlexRay Compliance Test Application based on the FlexRay system’s 
specified gdTSSTransmitter timing parameter, gdBit and possible truncation.

Figure 13Measuring -width of TSS pulse

Test Procedure

Initial Setup

1 Configure the FlexRay DUT such that it acts as a source for FlexRay signal.

2 On the Oscilloscope:

a Set to Default Setup.

b Set Triggered Mode as Normal.

c Set the Initial V/div = 1V/div, Offset = 0V.

d On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as Signal Generator Clock gated by T-Enable:

• Trigger = 50ns < +PW < 150ns
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• Trigger level = -300mV

• Noise Reject = ON

• Timebase = 20ns/div, Delay = 0.0s

e On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Serial Decode = FlexRay = ON

• VPT1000 mode = Synchronous or Asynchronous

• Trigger Type = FlexRay, Mode = Frame

• Frame ID = N, Cycle Rep = All

• Delay = 0.0

• If 10 Mbps, Timebase = 2.0us/div

• If 5 Mbps, Timebase = 4.0us/div

• If 2.5 Mbps, Timebase = 8.0us/div

f Measure Vpp with stats.

g Perform Query measurement.

h Compute V/div-optimum = ~Vpp(max)/6

i Set selected Channel V/div = V/div-optimum

j On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Measure “T@V” on first falling edge @ V = -300mV

• Result = dTSS (This value of time denotes the beginning of the frame relative 
to the trigger point you set. This value is used later for delay settings.)

k Clear measurement.

TSS Width Measurement

1 Skip this measurement if you select Transmitter Signal Source as Signal Generator 
Clock gated by T-Enable

2 Run the tests on the FlexRay Compliance Test Application.

3 Set Serial Decode = FlexRay to ON.

4 Set VPT1000 mode to Synchronous or Asynchronous, based on selection in the 
Set Up tab.

5 Set Trigger = FlexRay Frame ID = N, Cycle Rep = All

6 Set Timebase as:

• 500ns/div, for Baud Rate 10Mbps

• 1us/div, for Baud Rate 5Mbps

• 2us/div, for Baud Rate 2.5 Mbps
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7 Set Delay as the measurement of time at the voltage on the first falling edge, 
which is at V=-0.3V.

8 Set the Upper Threshold to -280mV.

9 Set Lower Threshold to -300mV.

10 Set Middle Threshold to -320mV.

11 Measure -Width with stats.

12 Stop Acquisition.

13 Run a query for measurement stats.

14 Transfer image.

15 Compare the test results with the compliance test limits.

Expected/Observable Results

The signal obtained from the test must meet the following limits as per the FlexRay 
Communications System Electrical Physical Layer Specification, Version 2.1, 
Revision E:

(For Baud Rate 10Mbps) 6gdBit (590ns) < gdTSSTransmitter < 15gdBit (1.51us)

(For Baud Rate 5Mbps) 4gdBit (780ns) < gdTSSTransmitter < 8gdBit (1.62us)

(For Baud Rate 2.5 Mbps) 3gdBit (1.16us) < gdTSSTransmitter < 5gdBit (2.04us)



38 Keysight FlexRay Compliance Test Application Methods of Implementation

2 About the Tests
 

1.5 Mean Corrected Cycle Time

Test Overview

The purpose of this test is to verify that the average value of the cycle time of the 
Device Under Test (DUT) is within the conformance limits specified in the FlexRay 
Communications System Electrical Physical Layer Specification, Version 2.1, 
Revision E.

Figure 14Selection of Mean Corrected Cycle Time Test in the Compliance Test Application

Mean Corrected Cycle Time—Uses the Oscilloscope’s Segmented Memory 
Acquisition mode to capture 1001 consecutive frames of the specified ID with 
precise time-tagging between each frame. The FlexRay Compliance Test 
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Application computes the average cycle time at a transmitter test plane 
differential probing point. The results are for “information-only” and must not be 
compared against any specified or non-specified test limits.

Figure 15Cycle Time and Timebase Accuracy Test using Segmented Memory Acquisition

Test Procedure

Initial Setup

1 Configure the FlexRay DUT such that it acts as a source for FlexRay signal.

2 On the Oscilloscope:

a Set to Default Setup.

b Set Triggered Mode as Normal.

c Set the Initial V/div = 1V/div, Offset = 0V.

d On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as Signal Generator Clock gated by T-Enable:

• Trigger = 50ns < +PW < 150ns

• Trigger level = -300mV

• Noise Reject = ON

• Timebase = 20ns/div, Delay = 0.0s

e On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:
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• Serial Decode = FlexRay = ON

• VPT1000 mode = Synchronous or Asynchronous

• Trigger Type = FlexRay, Mode = Frame

• Frame ID = N, Cycle Rep = All

• Delay = 0.0

• If 10 Mbps, Timebase = 2.0us/div

• If 5 Mbps, Timebase = 4.0us/div

• If 2.5 Mbps, Timebase = 8.0us/div

f Measure Vpp with stats.

g Perform Query measurement.

h Compute V/div-optimum = ~Vpp(max)/6

i Set selected Channel V/div = V/div-optimum

j On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Measure “T@V” on first falling edge @ V = -300mV

• Result = dTSS (This value of time denotes the beginning of the frame relative 
to the trigger point you set. This value is used later for delay settings.)

k Clear measurement.

Mean Corrected Cycle Time

1 Skip this measurement if you select Transmitter Signal Source as Signal Generator 
Clock gated by T-Enable

2 Run the tests on the FlexRay Compliance Test Application.

3 Set Delay as the measurement of time at the voltage on the first falling edge, 
which is at V=-0.3V.

4 Set Timebase as:

• 500ns/div, for Baud Rate 10Mbps

• 1us/div, for Baud Rate 5Mbps

• 2us/div, for Baud Rate 2.5 Mbps

5 Stop the test run.

6 Initiate the Transfer protocol.

7 Note the Frame type (NORM, SUYNC, SUP, NULL).

8 Set Acquisition Mode as Segmented Memory.

9 Set # of segments as 1001.

10 Set Segmented = ON.

11 Run the tests.
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12 Record the time-tag of segment#1001.

13 Transfer Image.

Expected/Observable Results

The results are for “information-only” purposes and must not be compared against 
any specified or non-specified test limits.
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1.6 Signal Integrity Voting Tests

Test Overview

The purpose of this test is to verify that the signal from the Device Under Test 
(DUT) meets the minimal signal shape requirement according to the FlexRay 
Communications System Electrical Physical Layer Specification, Version 2.1, 
Revision E.

Figure 16Selection of Signal Integrity Voting Procedure Test in the Compliance Test 
Application

Signal Integrity Voting—This is a procedure given by the BD properties and its 
robustness against disturbances. The procedure detects whether a FlexRay 
topology is operable or not. You must take into account the differential bus signal 
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shapes measured at any position. This procedure involves mathematical 
calculation. This procedure must meet the following conditions for the test to 
Pass:

• The differential voltage level must be high enough.

• The shortest detectable duration of one bit must be long enough.

• The asymmetry of the measured bit must be less than the defined limit.

• Idle detection between frames must be avoided.

Figure 17Capturing an isolated “one” by triggering on cycle#4
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Figure 18Capturing an isolated “zero” by triggering on cycle#59
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References

(*) shortest bit that has to be sent by a BD on the bus (minimum of dRx0 and dRx1, see Figure 8-6 in the FlexRay 
Communications System Electrical Physical Layer Specification, Version 2.1, Revision E.

(**) maximal allowed asymmetry of the receiving BD (point-to-point or passive bus and virtually measured: TP4 to 
TP4-BDi).

(***) 3ns (**) + 4ns for the passive star.

The result is coded in the value Sq:

pass — the differential signal meets the minimal signal shape requirements (level and delay)

fail — the differential signal does not the minimal signal shape requirements (level or delay)

Table 3 Signal Voting — Parameter list

Signal Voting Parameter Name Description

IN

uBUSTPx’ Filtered differential voltage

dBitShort Shortest detectable duration of one bit

dBitLong Longest detectable duration of one bit

dEdgeMax Duration of the slowest edge

OUT Sq Voted signal quality

PARAMETER

dAsymmetricDelayMax Required maximal asymmetric delay
—passive star: 7ns (***)
—terminated point-to-point: 3ns (**)
—passive bus: 3ns (**)

dBitMin Required minimum duration of the shortest bit at TP4_BDi: 
67ns [=70ns (*) - 3ns (**)]

uData0Top Required minimal level (Top): -330mV

uData1Top Required maximal level (Top): 330mV

dIdleDetectionMin Minimal Timeout to detect Idle: 50ns

Table 4 Signal Voting Procedure — Calculation Method

BEHAVIOR

IF dAsymmetricDelay <= dAsymMax
AND uBusTPx’ >= uData1Top

AND dBitShort >= dBitMin
AND dEdgeMax <= dIdleDetectionMin
THEN Sq = “pass”
ELSE Sq = “fail”

IF dAsymmetricDelay <= dAsymMax
AND uBusTPx’ <= uData0Top

AND dBitShort >= dBitMin
AND dEdgeMax <= dIdleDetectionMin
THEN Sq = “pass”
ELSE Sq = “fail”
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Test Procedure

Initial Setup

1 Configure the FlexRay DUT such that it acts as a source for FlexRay signal.

2 On the Oscilloscope:

a Set to Default Setup.

b Set Triggered Mode as Normal.

c Set the Initial V/div = 1V/div, Offset = 0V.

d On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as Signal Generator Clock gated by T-Enable:

• Trigger = 50ns < +PW < 150ns

• Trigger level = -300mV

• Noise Reject = ON

• Timebase = 20ns/div, Delay = 0.0s

e On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Serial Decode = FlexRay = ON

• VPT1000 mode = Synchronous or Asynchronous

• Trigger Type = FlexRay, Mode = Frame

• Frame ID = N, Cycle Rep = All

• Delay = 0.0

• If 10 Mbps, Timebase = 2.0us/div

• If 5 Mbps, Timebase = 4.0us/div

• If 2.5 Mbps, Timebase = 8.0us/div

f Measure Vpp with stats.

g Perform Query measurement.

h Compute V/div-optimum = ~Vpp(max)/6

i Set selected Channel V/div = V/div-optimum

j On the FlexRay Compliance Test Application, if you select Transmitter Signal 
Source as FlexRay Communication Controller generated traffic:

• Measure “T@V” on first falling edge @ V = -300mV

• Result = dTSS (This value of time denotes the beginning of the frame relative 
to the trigger point you set. This value is used later for delay settings.)

k Clear measurement.
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Isolated One

1 Set Time Ref as Center.

2 Set Timebase as:

• 50ns/div, Delay = -570ns for Baud Rate 10Mbps

• 100ns/div, Delay = -800ns for Baud Rate 5Mbps

• 200ns/div, Delay = -1.3us for Baud Rate 2.5 Mbps

3 Offset = 0V.

4 Set Serial Decode as FlexRay = ON.

5 VPT1000 mode = Synchronous or Asynchronous.

6 Trigger = FlexRay, Mode = Frame.

7 Cycle Rep = 64, Cycle Base = 4.

8 Frame ID = N.

9 Single.

10 Transfer the waveform data to MATLAB function.

11 Compute results as:

• uData1Top = Vtop

• dEdgeMax = RTmax or FTmax

• dBitlong = PWmax

• dBitShort = PWmin

• dBitLengthVariation = dBitLong - dBitShort

12 Determine Pass/Fail criteria for isolated “one” (Data1):

If dBitLengthVariation-Data1 <= 7ns

AND uData1Top >= 300mV

AND dBitShort-Data1 > 69.95ns for 10Mbps

(OR) dBitShort-Data1 > 133.40ns for 5Mbps

(OR) dBitShort-Data1 > 260.30ns for 2.5Mbps

AND dEdgeMax-Data1 <= 50ns

THEN PASS for Signal Quality (Sq-Data1) test#1

Isolated Zero

1 Cycle Base = 59.

2 Single.

3 Transfer the waveform data to MATLAB function.

4 Compute results as:
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• uData0Top = Vbase

• dEdgeMax = RTmax or FTmax

• dBitlong = -PWmax

• dBitShort = -PWmin

• dBitLengthVariation = dBitLong - dBitShort

5 Determine Pass/Fail criteria for isolated “zero” (Data0):

If dBitLengthVariation-Data0 <= 7ns

AND uData0Top >= -300mV

AND dBitShort-Data0 > 69.95ns for 10Mbps

(OR) dBitShort-Data0 > 133.40ns for 5Mbps

(OR) dBitShort-Data0 > 260.30ns for 2.5Mbps

AND dEdgeMax-Data0 <= 50ns

THEN PASS for Signal Quality (Sq-Data0) test#1

If any of the above conditions fail, THEN FAIL for Signal Quality (Sq-Data0) 
test#1

MATLAB Function

1 Filter both Isolated “One” and “Zero” waveforms with a 14MHz low pass single 
pole filter.

2 Measure RT (-300mV to 300mV) and FT (-300mV to 300mV).

3 Vtop for isolated “One” and Vbase for isolated “Zero”.

4 +PW on isolated “One” filtered waveform at 16 distinct upper/lower threshold 
settings specified in the table.

5 -PW on isolated “Zero” filtered waveform at 16 distinct upper/lower threshold 
settings specified in the table.

Expected/Observable Results

The results obtained must meet the PASS condition as specified in the FlexRay 
Communications System Electrical Physical Layer Specification, Version 2.1, 
Revision E.
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